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Basic custom plugin development in C++



Introduction to Basic custom plugin development in C++
Do you want to be able to extend Dewesoft on your own? With the help of C++ Plugin you can create your own plugins and
integrate them into any Dewesoft. Since C++ Plugin uses Dewesoft internals, it can do anything that Dewesoft can. You can
take arbitrarily many input channels, process the data using modern C++, output the results into output channels, change
Dewesoft settings, and much much more!

C++ Plugin also allows you to create your very own user interface which is, together with your C++ code, compiled into an
external library and automatically recognised and loaded by Dewesoft. This is why your plugin can be easily exported and
imported for use on other computers.

All the examples of C++ Plugins we will create and the setups we will use in this tutorial are available on Dewesoft's
webpage under Support > Downloads > Developers > C++ Plugin. Note that you have to be logged in to access the C++
Plugin section. 
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https://download.dewesoft.com/list/developers/c-plugin


How to Install the Dewesoft plugin template?
In order to start using C++ Plugin, you must have Visual Studio IDE installed on your system. Some of the reasons we have
chosen Visual Studio are its functionalities, powerful developer tooling, like IntelliSense code completion and debugging,
fast code editor, easy modification/customization and many more. 

Dewesoft plugin for Visual Studio development can be found on the Dewesoft webpage under  Support -> Downloads ->
Developers -> C++ Plugin. Note that you have to be logged in to access the C++ Plugin section. After downloading, just
double-click the VSIX file and the installer will guide you through the installation process.

Once VSIX plugin is downloaded and installed you will be able to create the Dewesoft C++ plugin using the New project
window and selecting the DewesoftX C++ Plugin. 
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https://download.dewesoft.com/list/2/181
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Example: Latch math
To get a better understanding of how to work with C++ Plugin we will implement a latch math module. Latch math outputs
the value of an input channel when some other input channel crosses some predefined criteria. An example use case of
this module could be to monitor your car engine RPM as you pass 100 km/h: we just set the first input channel to engine
RPM, the second input channel to the channel with our car's current speed, and set the criteria to 100 km/h.

Given this, at the end of the example, we should end up with a working module that allows you to select two input channels,
one to look for latch criteria points and one from which the outputted values will be read, and produce an output channel
with these values. 

Signals for testing our module
Before we begin creating our C++ Plugin, let's first create the two input signals we will use to test it. Open Dewesoft, click
on the New setup button and then click Math.

The first signal will be the one we will use to look for criteria limit crossing. For our testing purposes, this signal will be a
sine with a frequency of 1 Hz. We can create it by clicking the Formula button next to the Add math button and add sine
function from the Signal tab. Let's name it "sine(1)". In the formula area write the following line:

sinesine((11))

The second signal will be the one from which we read the values to output at criteria limit. This signal will be the current
time. We add it by clicking the Formula button next to the Add math button and add time function from the Signal tab,
naming it "time". 

timetime

Don't forget to save the setup!
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Example: New C++ Plugin
Now we go back to Visual Studio. To create a new C++ Plugin we click the Project button in File tab > New > Project. We
select the Dewesoft X Plugin Template as our template and fill in the name of our project. After clicking the Ok button a
wizard window will appear to guide us through the creation of the plugin.

Since your plugin will be integrated inside Dewesoft, it needs to know Dewesoft's location. We can define the location by
ourselves and the installer will create DEWESOFT_EXE_X86 (for 32-bit Dewesoft) and DEWESOFT_EXE_X64 (for 64-bit
Dewesoft) system variables for us. In that case, Visual Studio will have to be restarted so it will update its used
environmental variables state. 

Once those system variables are set, installer will automatically find those fields for you and you will not have to specify
the location for further usages.

If we want to set those variables ourselves, we can do this using System properties window (it can be found pressing
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Windows key and searching for Edit the system environment variables), and under advanced tab clicking the Environment
variables. 

If you only have the 64-bit (or 32-bit) version of Dewesoft on your computer, you will only be able to create 64-bit (or 32-bit)
plugins.

After clicking the Next button the following window appears which is used to set Plugin information such as plugin name,
its ownership, and version.

Plugin name - The name that will be seen in Dewesoft.
Description - Short description of your plugin.
Vendor - Company that created the plugin.
Copyright - Owner of the plugin.
Major version - Sets the initial major version. The value should change when a breaking change occurs (it's
incompatible with previous versions).
Minor version - Sets the initial minor version. The value should change when new features and bug fixes are added
without breaking compatibility.
Release version - Sets the initial release version. The value should change if the new changes contain only bugfixes.

All fields are optional except for the Plugin name, and they can all be modified later from the code.

After clicking the Next button a final window appears. This window is used to set your Base class name. It is used as a
prefix for class and project name. When the Base class name is set, we can click the Finish button and the wizard will
generate the plugin template based on your choices. 
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Below the base class name, you can see a dropdown menu, where you can select the example which will be generated for
you. There are two options, one is a sine wave example, which will set everything up for outputing a sine wave values to the
output channel. The other option is Empty example, which will remove all example code from the project. We recommend
using this if you already have some knowledge about Dewesoft plugin development.

The Project name is the name of the file created by the Visual Studio.
The Plugin name is is the name of the plugin as seen in Dewesoft.
The Base class name is the name of the plugin inside of Visual Studio and has to be a valid C++ name.

When a new C++ Plugin project is created, the wizard will create the basic files and project structure needed for
development. In the picture below you can see the structure of a project in a tree view with collapsed items. In our case,
ProTutorial refers to text, which was used as the Base class name.

proTutorial_latchMath_scalar - Used for communication with Dewesoft through its DCOM interface and creating the
Plugin UI.
proTutorial_latchMath_scalarLib - Your main plugin logic should be defined here. In Example I, we will write plugin logic
inside the Plugin project to simplify things.
proTutorial_latchMath_scalarTest - Contains test cases that will be run during unit testing. 
gtest - Simple library, required by ProTutorialPluginTest for unit testing your plugin. This project should not be
modified. 

When the solution is built for the Irst time, we recommend rescanning it (to clear cache). If not, some false positive errors
might appear and auto-complete might not work. You can do this by clicking on the Project tab and choosing the Rescan
solution from the drop-down list.
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Once the plugin is created and you stumble upon Error MSB8036: The Windows SDK version sdk_version was not found.
You should retarget your solution to use the one you have installed. You can do this by right clicking on your solution node
in Solution explorer and selecting Retarget solution.

Once the Retarget solution window is opened, you can select "Latest installed version" item.

When our project is successfully generated, we will be able to extend Dewesoft. But before implementing the logic behind
our plugin, let's take a look at how our plugin is integrated into Dewesoft. In order to do that, we have to start our program
using the shortcut F5 or pressing the Start button in the center of Visual Studio's main toolbar. 
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After Dewesoft loads, our plugin can be accessed in Dewesofts main toolbar in Measure mode under Ch. setup ->
ProTutorial. As we can see, it already contains some example elements which were automatically added to the user
interface.

The user interface shown above is defined inside the setup_window.xml file. There are more user interfaces in the project
(Setup, Settings), each is found in a different location inside Dewesoft and has a different purpose.
* Setup
- Found in the Dewesoft main toolbar.
- Your main plugin user interface should be defined here.
* Settings
- Found in Options > Settings > Extensions > Plugin.
- General settings, variables, properties, and paths, which are set once and rarely changed should be defined here.

Files associated with them can be found in Visual Studios Solution explorer by expanding ProTutorialPlugin > UI folder. 
If your plugin is not visible in Dewesoft you must manually add it. Click the Options icon in the top right corner and from the

drop-down list choose Settings. Go to the Extensions tab, click the button and find your plugin. Click on it and then
click the Enable button on the right.
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Example I: Creating custom UI
We are now ready to start creating the plugin for Latch math. We will start by taking a look at the already existing UI for
latch math that is integrated into Dewesoft. It can be found in Measure mode -> Math -> Add math -> Latch value math. Keep
in mind that this is a basic tutorial so we will keep things simple. Our goal is to recreate the UI on the right side of the
picture below. We will not use the channel preview (bottom left corner), we will only allow the user to pick one Input
channel and one Criteria channel and the Output value will be set to Actual by default, so we will not allow the user to change
it. We will also add Radio buttons where the user will choose if we are looking for the latch condition at rising or falling
edge.

Therefore, we will need two ComboBoxes (control, which contains a drop-down menu where only one item can be
selected), both displaying channel names. One will be used for selecting the Input channel and the other will be used for
selecting the Criteria channel. We will also need a TextBox (control, which displays a user-editable text) so the user will be
able to enter the Criteria limit and a Label (control, which displays read-only text) that will be added to the TextBox so it will
be more descriptive. Finally, we will need two RadioButtons (control, whose Checked property can be changed by clicking
on it) for determining whether we are calculating rising or falling edge. 

We will visually group settings for Input channel and Criteria channel using CaptionPanel (layout control with a title) and a
Grid (a type of layout, which arranges its child controls in an arbitrary number of rows and columns that can be spanned).
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We are now ready to create our custom user interface for latch math. The user interface is defined in the setup_window.xml
file by using simple, XAML-like syntax. The XML code for our UI will be presented in smaller pieces so it will be easier to
explain and understand. For each code snippet, there will be a picture added so you can see what the code creates. Your
user interface can be seen inside Dewesoft when the plugin is run.

<<??xml versionxml version=="1.0""1.0" encoding encoding=="utf-8""utf-8"??>>
<<Window xmlnsWindow xmlns=="https://mui.dewesoft.com/schema/1.1""https://mui.dewesoft.com/schema/1.1">>
        <<GridGrid>>
                <<GridGrid..ColumnDefinitionsColumnDefinitions>>
                        <<ColumnDefinition Width ColumnDefinition Width =="170""170"//>>
                        <<ColumnDefinition Width ColumnDefinition Width =="100%""100%"//>>
                <<//GridGrid..ColumnDefinitionsColumnDefinitions>>
                <<GridGrid..RowDefinitionsRowDefinitions>>
                        <<RowDefinition HeightRowDefinition Height=="100%""100%"//>>
                <<//GridGrid..RowDefinitionsRowDefinitions>>

This part of the code contains a Grid that will split your UI into two columns. The first column will have a width of 170 pixels
and the second column will take the remaining window width (e.g. if the window width is 500 pixels the second column will
have a width of 330px). If the window is resized, the width of the first column will remain fixed but the width of the second
column will be adapted to fit the window. As you can see the greed also contains a row, which takes the entire window
height. 

When using a Grid, it is important to set Grid.ColumnDefinitions and Grid.RowDefinitions, even if there is only one column
or row.
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                <<CaptionPanel GridCaptionPanel Grid..ColumnColumn=="0""0" Title Title=="Input""Input">>
                        <<GridGrid>>
                                <<GridGrid..RowDefinitionsRowDefinitions>>
                                        <<RowDefinition HeightRowDefinition Height=="20""20"//>>
                                        <<RowDefinition HeightRowDefinition Height=="100%""100%"//>>
                                <<//GridGrid..RowDefinitionsRowDefinitions>>
                                <<GridGrid..ColumnDefinitionsColumnDefinitions>>
                                        <<ColumnDefinition WidthColumnDefinition Width=="100%""100%"//>>
                                <<//GridGrid..ColumnDefinitionsColumnDefinitions>>

                                <<Label TextLabel Text=="Input channel""Input channel" Grid Grid..RowRow=="0""0"  //>>
                                <<ComboBox MarginRightComboBox MarginRight=="20""20" Grid Grid..RowRow=="1""1" Name Name=="inputChannelName""inputChannelName"  //>>
                        <<//GridGrid>>
                <<//CaptionPanelCaptionPanel>>

With the code above we will add CaptionPanel to the first column of our main Grid. This is done by adding
GridGrid..ColumnColumn=="0""0" to the CaptionPanel. The Grid inside the CaptionPanel contains two rows, one for the Label and one for
the ComboBox. 

Note that we have added Name properties to components. Names are required to access components from the C++ code
so they have to be unique.
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                <<CaptionPanel GridCaptionPanel Grid..ColumnColumn=="1""1" Title Title=="Latch criteria settings""Latch criteria settings">>
                        <<GridGrid>>
                                <<GridGrid..ColumnDefinitionsColumnDefinitions>>
                                        <<ColumnDefinition WidthColumnDefinition Width=="140""140"//>>
                                        <<ColumnDefinition WidthColumnDefinition Width=="30""30"//>>
                                        <<ColumnDefinition WidthColumnDefinition Width=="120""120"//>>
                                        <<ColumnDefinition WidthColumnDefinition Width=="100%""100%"//>>
                                <<//GridGrid..ColumnDefinitionsColumnDefinitions>>
                                <<GridGrid..RowDefinitionsRowDefinitions>>
                                        <<RowDefinition HeightRowDefinition Height=="20""20"//>>
                                        <<RowDefinition HeightRowDefinition Height=="20""20"//>>
                                        <<RowDefinition HeightRowDefinition Height=="10""10"//>>
                                        <<RowDefinition HeightRowDefinition Height=="20""20"//>>
                                        <<RowDefinition HeightRowDefinition Height=="20""20"//>>
                                        <<RowDefinition HeightRowDefinition Height=="100%""100%"//>>
                                <<//GridGrid..RowDefinitionsRowDefinitions>>

                                <<Label GridLabel Grid..ColumnColumn=="0""0" Text Text=="Criteria channel""Criteria channel"//>>
                                <<ComboBox GridComboBox Grid..ColumnColumn=="0""0" Grid Grid..RowRow=="1""1" Name Name=="criteriaChannelName""criteriaChannelName"  //>>
                                <<Label GridLabel Grid..ColumnColumn=="2""2" Text Text=="Criteria limit""Criteria limit"  //>>
                                <<TextBox GridTextBox Grid..ColumnColumn=="2""2" Grid Grid..RowRow=="1""1" Name Name=="latchCriteria""latchCriteria" Text Text=="0""0">><<//TextBoxTextBox>>
                                <<RadioButton GridRadioButton Grid..ColumnColumn=="0""0" Grid Grid..RowRow=="3""3" Name Name=="risingEdge""risingEdge" Label Label=="Rising edge""Rising edge"  
IsCheckedIsChecked=="True""True"  //>>
                                <<RadioButton GridRadioButton Grid..ColumnColumn=="0""0" Grid Grid..RowRow=="4""4" Name Name=="fallingEdge""fallingEdge" Label Label=="Falling edge""Falling edge"  //>>
                        <<//GridGrid>>
                <<//CaptionPanelCaptionPanel>>
        <<//GridGrid>>
<<//WindowWindow>>

And lastly, we add the code for filling out the second column of our main Grid. This one is a bit more complex since
elements need to be aligned and visually grouped (items that are connected should be closer. e.g. Criteria limit caption
Label and TextBox). That is why we have created another Grid element with six rows and four columns, where our
components can be inserted.

MUI Designer
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So far we have tested our user interface inside Dewesoft by running our plugin. When editing the UI it is not necessary to
run the plugin every time we want to see the changes we made. We can use MUI Designer, which live previews your design.
It can be found in Visual Studio > View > Other windows > MUI Designer (Dewesoft).

In the picture below you can see our final user interface in MUI Designer. The preview is automatically refreshed when the
code is changed and if we run the plugin in Dewesoft the UI will look and behave exactly like shown in the MUI Designer.

Adding XML components is not only possible by manually typing them out; we can use the MUI Snippets window, which
contains all available controls, to automate the typing. It can be found in Visual Studio > View > Other Windows > MUI
Snippet (Dewesoft). Adding code is extremely simple: all we have to do is place the caret where we wish the text to be
inserted and double-click the desired control.
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Example I: Accessing the UI component using C++
We have now created the user interface for our plugin but it is not really doing anything at the moment. We still have to add
some functionality to the UI components. 

It is important to keep in mind that C++ uses header files (you can recognize them by the .h extension) in addition to source
files. Header files are designed to provide information about your class and are used for declaration of variables and
methods, while their initialization is done in the source files with .cpp extension. Before writing our own code, we will first
remove the sample code as it is not needed. Our setup_window.h should look like this:

##pragmapragma once once
##includeinclude  <mui/ds_window.h><mui/ds_window.h>
##includeinclude  <mui/controls.h><mui/controls.h>
##includeinclude  <mui/layout.h><mui/layout.h>

class DewesoftBridgeclass DewesoftBridge;;

class SetupWindow class SetupWindow :: public Dewesoft public Dewesoft::::MUIMUI::::DSWindowDSWindow
{{
publicpublic::
        SetupWindowSetupWindow((DewesoftDewesoft::::MUIMUI::::WindowPtr uiWindowPtr ui,, DewesoftBridge DewesoftBridge&& bridge bridge));;

privateprivate::
    DewesoftBridge    DewesoftBridge&& bridge bridge;;
}};;

and setup_window.cpp should look like this: 

##includeinclude  "StdAfx.h""StdAfx.h"
##includeinclude  "setup_window.h""setup_window.h"
##includeinclude  "dewesoft_bridge.h""dewesoft_bridge.h"
##includeinclude  <thread><thread>
##includeinclude  <chrono><chrono>
##includeinclude  <regex><regex>

using namespace Dewesoftusing namespace Dewesoft::::MUIMUI;;
using namespace Dewesoftusing namespace Dewesoft::::RTRT::::CoreCore;;

SetupWindowSetupWindow::::SetupWindowSetupWindow((WindowPtr uiWindowPtr ui,, DewesoftBridge DewesoftBridge&& bridge bridge))  
        ::  DSWindowDSWindow((uiui,,  "ui/setup_window.xml""ui/setup_window.xml"))
        ,,  bridgebridge((bridgebridge))
{{
}}

Our new components will be declared in setup_window.h file. We usually keep components in the private section of our
class. We then forward all the information from the controls and their events to the bridge that will handle all the
communication with Dewesoft.
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privateprivate::
    DewesoftBridge    DewesoftBridge&& bridge bridge;;

    Dewesoft    Dewesoft::::MUIMUI::::ComboBox criteriaChannelCBoxComboBox criteriaChannelCBox;;
    Dewesoft    Dewesoft::::MUIMUI::::ComboBox inputChannelCBoxComboBox inputChannelCBox;;
    Dewesoft    Dewesoft::::MUIMUI::::TextBox latchCriteriaTBoxTextBox latchCriteriaTBox;;
    Dewesoft    Dewesoft::::MUIMUI::::RadioButton risingEdgeRButtonRadioButton risingEdgeRButton;;
    Dewesoft    Dewesoft::::MUIMUI::::RadioButton fallingEdgeRButtonRadioButton fallingEdgeRButton;;

Members are later initialized in setup_window.cpp file where we connect them with UI component by specifying the
component name. In our case this is done in the class constructor by using the ConnectConnect method. 

SetupWindowSetupWindow::::SetupWindowSetupWindow((WindowPtr uiWindowPtr ui,, DewesoftBridge DewesoftBridge&& bridge bridge))
        ::  DSWindowDSWindow((uiui,,  "ui/setup_window.xml""ui/setup_window.xml"))
        ,,  bridgebridge((bridgebridge))
{{
    criteriaChannelCBox     criteriaChannelCBox == ComboBox ComboBox::::ConnectConnect((uiui,,  "criteriaChannelName""criteriaChannelName"));;
    inputChannelCBox     inputChannelCBox == ComboBox ComboBox::::ConnectConnect((uiui,,  "inputChannelName""inputChannelName"));;
    latchCriteriaTBox     latchCriteriaTBox == TextBox TextBox::::ConnectConnect((uiui,,  "latchCriteria""latchCriteria"));;
    risingEdgeRButton     risingEdgeRButton == RadioButton RadioButton::::ConnectConnect((uiui,,  "risingEdge""risingEdge"));;
    fallingEdgeRButton     fallingEdgeRButton == RadioButton RadioButton::::ConnectConnect((uiui,,  "fallingEdge""fallingEdge"));;
}}

After successfully connecting the UI components we now need to get the available channels from Dewesoft and list their
names in ComboBoxes so the user can see and choose them. To make our calculation easier, our input channels will be
synchronous (time difference between two sequential samples is always the same). We first have to get all the available
channels from Dewesoft and filter out all but the synchronous ones. 

In order to do so, we have to access Dewesoft internals, which can be done inside the DewesoftBridge (you can find it in the
dewesoft_bridge.h and dewesoft_bridge.cpp).  The channel information is stored in the bridge member variable appapp which
represents the Dewesoft DCOM interface. We create a getter function called getSyncChannelsgetSyncChannels (()) that will read the
channels from appapp, filter them and return only the synchronous ones. 
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// dewesoft_bridge.h// dewesoft_bridge.h
// this method needs to be public// this method needs to be public
stdstd::::vectorvector<<IChannelPtrIChannelPtr>>  getSyncChannelsgetSyncChannels(());;

// dewesoft_bridge.cpp// dewesoft_bridge.cpp
stdstd::::vectorvector<<IChannelPtrIChannelPtr>> DewesoftBridge DewesoftBridge::::getSyncChannelsgetSyncChannels(())
{{
    std    std::::vectorvector<<IChannelPtrIChannelPtr>> allSyncChannels allSyncChannels;;

    app    app->->DataData->->BuildChannelListBuildChannelList(());;
    IChannelListPtr channels     IChannelListPtr channels == app app->->DataData->->UsedChannelsUsedChannels;;

        forfor  ((intint i  i ==  00;; i  i << channels channels->->CountCount;; i i++++))
                ifif  ((!!channelschannels->->GetItemGetItem((ii))->->AsyncAsync))
            allSyncChannels            allSyncChannels..push_backpush_back((channelschannels->->GetItemGetItem((ii))));;

        returnreturn allSyncChannels allSyncChannels;;
}}

Once getSyncChannelsgetSyncChannels(()) function is written, we are ready to insert channel names into CheckBoxes. We will do this in a
constructor in the file setup_window.cpp below the initialization of the controls. The criteriaChannelCBoxcriteriaChannelCBox  and
inputChannelCBoxinputChannelCBox refer to CheckBoxes in which channel names will be inserted. To insert channel names to ComboBox,
we will create a function called voidvoid  addChannelsToCBoxaddChannelsToCBox(());;, which should be public because we will need it later inside
of the bridge.

// setup_window.h // setup_window.h 
voidvoid  addChannelsToCBoxaddChannelsToCBox(());;
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// setup_window.cpp// setup_window.cpp
SetupWindowSetupWindow::::SetupWindowSetupWindow((WindowPtr uiWindowPtr ui,, DewesoftBridge DewesoftBridge&& bridge bridge))
        ::  DSWindowDSWindow((uiui,,  "ui/setup_window.xml""ui/setup_window.xml"))
        ,,  bridgebridge((bridgebridge))
{{
        // member initialization// member initialization
        // ...// ...
        addChannelsToCBoxaddChannelsToCBox(());;
}}

voidvoid SetupWindow SetupWindow::::addChannelsToCBoxaddChannelsToCBox(())
{{
    criteriaChannelCBox    criteriaChannelCBox..clearclear(());;
    inputChannelCBox    inputChannelCBox..clearclear(());;
    std    std::::vectorvector<<IChannelPtrIChannelPtr>> allChannels  allChannels == bridge bridge..getSyncChannelsgetSyncChannels(());;

        forfor  ((intint i  i ==  00;; i  i << allChannels allChannels..sizesize(());; i i++++))
        {{
        std        std::::string channelName string channelName == allChannels allChannels[[ii]]->->NameName;;
        criteriaChannelCBox        criteriaChannelCBox..addItemaddItem((channelNamechannelName));;
        inputChannelCBox        inputChannelCBox..addItemaddItem((channelNamechannelName));;
        }}
}}

If we now start Dewesoft, channel names should appear when we click on ComboBoxes.
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Example I: Handling events
We have now initialized all UI components we will need in our example, but these components don't do anything yet. To
bring them to life we need to introduce events to our code (e.g. Click, CheckedChanged, ...). To create an event all you have
to do is provide a method with the same signature as the control's event handler and then bind it to the control. 

A method signature is its return type, calling convention, and argument order and their types. Event handlers usually have
the signature of voidvoid((ComponentTypeComponentType&& sender sender,, EventArgsType EventArgsType&& args args)).

Event handlers are declared in the header files. Here you can see the declaration of event handlers that will be executed
when an event is triggered. This part of the code should be placed inside the private section in setup_window.h file.

privateprivate
        // ...// ...
        voidvoid  onCriteriaChannelChangedonCriteriaChannelChanged((DewesoftDewesoft::::MUIMUI::::ComboBoxComboBox&& cBox cBox,, Dewesoft Dewesoft::::MUIMUI::::EventArgsEventArgs&& args args));;
        voidvoid  onInputChannelChangedonInputChannelChanged((DewesoftDewesoft::::MUIMUI::::ComboBoxComboBox&& cBox cBox,, Dewesoft Dewesoft::::MUIMUI::::EventArgsEventArgs&& args args));;
        voidvoid  onEditTextChangedonEditTextChanged((DewesoftDewesoft::::MUIMUI::::TextBoxTextBox&& editBox editBox,, Dewesoft Dewesoft::::MUIMUI::::EventArgsEventArgs&& args args));;
        voidvoid  onRadioGroupChangedonRadioGroupChanged((DewesoftDewesoft::::MUIMUI::::RadioButtonRadioButton&& radioGroup radioGroup,, Dewesoft Dewesoft::::MUIMUI::::EventArgsEventArgs&&  
argsargs));;
}}

Because a component can have multiple event handlers bound to the same event, we use ++== operator for adding and --==
operator for removing event handlers. This can only be done after the variable is connected. In our case, we bind events in
the constructor immediately after connecting the variables. The code for how to bind events to our controls in
setup_window.cpp can be seen below. 

SetupWindowSetupWindow::::SetupWindowSetupWindow((WindowPtr uiWindowPtr ui,, DewesoftBridge DewesoftBridge&& bridge bridge))
        ::  DSWindowDSWindow((uiui,,  "ui/setup_window.xml""ui/setup_window.xml"))
        ,,  bridgebridge((bridgebridge))
{{              
        // member initialisation// member initialisation
        // adding channel names to ComboBoxes// adding channel names to ComboBoxes
        // ...// ...
    criteriaChannelCBox    criteriaChannelCBox..OnChange OnChange ++==  eventevent((&&SetupWindowSetupWindow::::onCriteriaChannelChangedonCriteriaChannelChanged));;
    inputChannelCBox    inputChannelCBox..OnChange OnChange ++==  eventevent((&&SetupWindowSetupWindow::::onInputChannelChangedonInputChannelChanged));;
    latchCriteriaTBox    latchCriteriaTBox..OnTextChanged OnTextChanged ++==  eventevent((&&SetupWindowSetupWindow::::onEditTextChangedonEditTextChanged));;
    risingEdgeRButton    risingEdgeRButton..OnCheckedChanged OnCheckedChanged ++==  eventevent((&&SetupWindowSetupWindow::::onRadioGroupChangedonRadioGroupChanged));;
    fallingEdgeRButton    fallingEdgeRButton..OnCheckedChanged OnCheckedChanged ++==  eventevent((&&SetupWindowSetupWindow::::onRadioGroupChangedonRadioGroupChanged));;
}}

Event handlers are defined in setup_window.cpp file. The following pictures will show which event handler is called when a
certain action is performed. 
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This part of the code is triggered if we click on an item (that is not already selected) inside ComboBox containing Criteria
channel names.

voidvoid SetupWindow SetupWindow::::onCriteriaChannelChangedonCriteriaChannelChanged((DewesoftDewesoft::::MUIMUI::::ComboBoxComboBox&& cBox cBox,,  
DewesoftDewesoft::::MUIMUI::::EventArgsEventArgs&& args args))
{{
    bridge    bridge..setCriteriaChannelNamesetCriteriaChannelName((cBoxcBox..getSelectedItemgetSelectedItem(())));;
}}
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This part of the code is triggered if we click on any item (that is not already selected) inside the ComboBox component
containing input channel names.

voidvoid SetupWindow SetupWindow::::onInputChannelChangedonInputChannelChanged((DewesoftDewesoft::::MUIMUI::::ComboBoxComboBox&& cBox cBox,,  
DewesoftDewesoft::::MUIMUI::::EventArgsEventArgs&& args args))
{{
    bridge    bridge..setInputChannelNamesetInputChannelName((cBoxcBox..getSelectedItemgetSelectedItem(())));;
}}
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This part of the code is triggered if we edit text in component marked with the red square in the picture above.

voidvoid SetupWindow SetupWindow::::onEditTextChangedonEditTextChanged((DewesoftDewesoft::::MUIMUI::::TextBoxTextBox&& editBox editBox,, Dewesoft Dewesoft::::MUIMUI::::EventArgsEventArgs&&  
argsargs))
{{
    bridge    bridge..setCriteriaLimitsetCriteriaLimit((stofstof((editBoxeditBox..getTextgetText(())..toStdStringtoStdString(())))));;
}}
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This part of the code is triggered if we click on the component marked with the red square in the picture above. 

voidvoid SetupWindow SetupWindow::::onRadioGroupChangedonRadioGroupChanged((RadioButtonRadioButton&& radioGroup radioGroup,, EventArgs EventArgs&& args args))
{{
        ifif  ((SetupWindowSetupWindow::::fallingEdgeRButtonfallingEdgeRButton..getIsCheckedgetIsChecked(())))
        bridge        bridge..setEdgeTypesetEdgeType((FallingEdgeFallingEdge));;
        elseelse
        bridge        bridge..setEdgeTypesetEdgeType((RisingEdgeRisingEdge));;
}}
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Example I: DewesoftBridge
The main purpose of DewesoftBridge is to allow your plugin to communicate with Dewesoft. It contains functions and
events, that are triggered at a certain time (e.g. when measuring is started, when measuring is stopped, when setup is
saved,...). The list of all function and events can be found in dewesoft_bridge.h file. In this section we will only mention
those used in order for our plugin to work as intended, others will remain unchanged.  We will use this class for
implementing the logic behind the latch math.

We will first make changes to the dewesoft_bridge.h file where we will declare methods and variables. For our plugin to
work we need variables for holding Criteria limit value, channel names and for determining whether we are calculating the
rising or falling edge. We will also create getter and setter functions for these variables. All of these variables and methods
are only going to be accessed inside the DewesoftBridge, so they should be private. 
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enumenum edgeTypes edgeTypes
{{
    RisingEdge     RisingEdge ==  00,,
    FallingEdge     FallingEdge ==  11
}};;

class DewesoftBridgeclass DewesoftBridge
{{
publicpublic::
        // ...// ...

        /* Declarations of methods we added*//* Declarations of methods we added*/
    std    std::::vectorvector<<IChannelPtrIChannelPtr>>  getSyncChannelsgetSyncChannels(());;

        voidvoid  setCriteriaChannelNamesetCriteriaChannelName((stdstd::::string namestring name));;
    std    std::::string string getCriteriaChannelNamegetCriteriaChannelName(());;

        voidvoid  setInputChannelNamesetInputChannelName((stdstd::::string namestring name));;
    std    std::::string string getInputChannelNamegetInputChannelName(());;

        voidvoid  setCriteriaChannelsetCriteriaChannel((stdstd::::string channelNamestring channelName));;
    IChannelPtr     IChannelPtr getCriteriaChannelgetCriteriaChannel(());;

        voidvoid  setInputChannelsetInputChannel((stdstd::::string channelNamestring channelName));;
    IChannelPtr     IChannelPtr getInputChannelgetInputChannel(());;

        voidvoid  setCriteriaLimitsetCriteriaLimit((floatfloat threshold threshold));;
        floatfloat  getCriteriaLimitgetCriteriaLimit(());;

        voidvoid  setEdgeTypesetEdgeType((edgeTypes typeedgeTypes type));;
    edgeTypes     edgeTypes getEdgeTypegetEdgeType(());;

privateprivate::
        // ...// ...

        /* Declarations of methods and variables we added *//* Declarations of methods and variables we added */
    std    std::::string inputChannelName string inputChannelName ==  """";;
    std    std::::string criteriaChannelName string criteriaChannelName ==  """";;
    IChannelPtr inputChannel    IChannelPtr inputChannel;;
    IChannelPtr criteriaChannel    IChannelPtr criteriaChannel;;

        floatfloat criteriaLimit  criteriaLimit ==  00;;
    edgeTypes edgeType     edgeTypes edgeType == RisingEdge RisingEdge;;

    int64_t lastPosChecked    int64_t lastPosChecked;;
}};;

Definitions of setters and getters should be written in dewesoft_bridge.cpp.
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voidvoid DewesoftBridge DewesoftBridge::::setCriteriaChannelNamesetCriteriaChannelName((stdstd::::string namestring name))
{{
    this    this->->criteriaChannelName criteriaChannelName == name name;;
}}
stdstd::::string DewesoftBridgestring DewesoftBridge::::getCriteriaChannelNamegetCriteriaChannelName(())
{{
        returnreturn this this->->criteriaChannelNamecriteriaChannelName;;
}}

voidvoid DewesoftBridge DewesoftBridge::::setInputChannelNamesetInputChannelName((stdstd::::string namestring name))
{{
    this    this->->inputChannelName inputChannelName == name name;;
}}
stdstd::::string DewesoftBridgestring DewesoftBridge::::getInputChannelNamegetInputChannelName(())
{{
        returnreturn this this->->inputChannelNameinputChannelName;;
}}

voidvoid DewesoftBridge DewesoftBridge::::setCriteriaChannelsetCriteriaChannel((stdstd::::string channelNamestring channelName))
{{
    criteriaChannel     criteriaChannel == app app->->DataData->->FindChannelFindChannel((channelNamechannelName..c_strc_str(())));;
}}
IChannelPtr DewesoftBridgeIChannelPtr DewesoftBridge::::getCriteriaChannelgetCriteriaChannel(())
{{
        returnreturn this this->->criteriaChannelcriteriaChannel;;
}}

voidvoid DewesoftBridge DewesoftBridge::::setInputChannelsetInputChannel((stdstd::::string channelNamestring channelName))
{{
    this    this->->inputChannel inputChannel == app app->->DataData->->FindChannelFindChannel((channelNamechannelName..c_strc_str(())));;
}}
IChannelPtr DewesoftBridgeIChannelPtr DewesoftBridge::::getInputChannelgetInputChannel(())
{{
        returnreturn this this->->inputChannelinputChannel;;
}}

voidvoid DewesoftBridge DewesoftBridge::::setCriteriaLimitsetCriteriaLimit((floatfloat threshold threshold))
{{
    this    this->->criteriaLimit criteriaLimit == threshold threshold;;
}}
floatfloat DewesoftBridge DewesoftBridge::::getCriteriaLimitgetCriteriaLimit(())
{{
        returnreturn this this->->criteriaLimitcriteriaLimit;;
}}

voidvoid DewesoftBridge DewesoftBridge::::setEdgeTypesetEdgeType((edgeTypes typeedgeTypes type))
{{
    this    this->->edgeType edgeType == type type;;
}}
edgeTypes DewesoftBridgeedgeTypes DewesoftBridge::::getEdgeTypegetEdgeType(())
{{
        returnreturn this this->->edgeTypeedgeType;;
}}
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In the rest of this section we mention methods which were modified so our plugin works as it should.

DewesoftBridge::mountChannels()
The voidvoid DewesoftBridge DewesoftBridge::::mountChannelsmountChannels(()) method is called when your plugin or setup is first loaded. This method
gives you the option to create your own output channels inside Dewesoft. In our example, the output channel should be of
an asynchronous type because we do not know exactly when a new sample will be added. We will set basic channel
properties like channel name, base type (synchronous, asynchronous type) and underlying data type.

voidvoid DewesoftBridge DewesoftBridge::::mountChannelsmountChannels(())
{{
        constconst std std::::vectorvector<<intint>> chIndexVector  chIndexVector ==  {{11}};;

    outputChannel     outputChannel == pluginGroup pluginGroup->->MountChannelExMountChannelEx((pluginGuidpluginGuid,,  longlong((chIndexVectorchIndexVector..sizesize(()))),,  
fromStdVecfromStdVec((chIndexVectorchIndexVector))));;

    outputChannel    outputChannel->->SetDataTypeSetDataType((longlong((ChannelDataTypeChannelDataType::::SingleSingle))));;
    outputChannel    outputChannel->->Name Name ==  "Latch""Latch";;
    outputChannel    outputChannel->->Unit_ Unit_ ==  """";;
    outputChannel    outputChannel->->SetAsyncSetAsync((truetrue));;
    outputChannel    outputChannel->->ExpectedAsyncRate ExpectedAsyncRate == app app->->DataData->->GetSampleRateExGetSampleRateEx(());;
    outputChannel    outputChannel->->Used Used == true true;;
}}

Dewesoft::onStartData()
This method gets called before the start of each measurement. Here we should initialize all variables used during our
measurement.

STDMETHODIMP DewesoftBridgeSTDMETHODIMP DewesoftBridge::::onStartDataonStartData(())
{{
        setInputChannelsetInputChannel((inputChannelNameinputChannelName..c_strc_str(())));;
        setCriteriaChannelsetCriteriaChannel((criteriaChannelNamecriteriaChannelName..c_strc_str(())));;
    lastPosChecked     lastPosChecked ==  00;;

        returnreturn S_OK S_OK;;
}}

DewesoftBridge::onGetData()
This method is called repeatedly during Measure mode. Here we can safely read from and write to the channels. We should
not perform any time-consuming tasks here. The method itself is marked as STDMETHODIMP, this is required for Dewesoft
to call this function over the DCOM interface. Keep in mind that the method gets a block of samples and not an individual
sample every time it gets called, so if we want to access every sample in the channel we need to create a loop that will
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perform this action. 

STDMETHODIMP DewesoftBridgeSTDMETHODIMP DewesoftBridge::::onGetDataonGetData(())
{{
        ifif  ((!!inputChannel inputChannel ||||  !!criteriaChannelcriteriaChannel))
                returnreturn S_OK S_OK;;

        // calculate the size of blocks in both channels// calculate the size of blocks in both channels
        intint blockSizeCriteriaChannel  blockSizeCriteriaChannel ==
                ((criteriaChannelcriteriaChannel->->DBPos DBPos --  ((lastPosChecked lastPosChecked %% criteriaChannel criteriaChannel->->DBBufSizeDBBufSize))  ++ criteriaChannel criteriaChannel--
>>DBBufSizeDBBufSize))  %% criteriaChannel criteriaChannel->->DBBufSizeDBBufSize;;
        intint blockSizeInputChannel  blockSizeInputChannel ==
                ((inputChannelinputChannel->->DBPos DBPos --  ((lastPosChecked lastPosChecked %% inputChannel inputChannel->->DBBufSizeDBBufSize))  ++ inputChannel inputChannel--
>>DBBufSizeDBBufSize))  %% inputChannel inputChannel->->DBBufSizeDBBufSize;;

        intint minBlockSize  minBlockSize ==  minmin((blockSizeCriteriaChannelblockSizeCriteriaChannel,, blockSizeInputChannel blockSizeInputChannel));;

        forfor  ((intint i  i ==  00;; i  i << minBlockSize  minBlockSize --  11;; i i++++))
        {{
                floatfloat currentSampleCriteriaChannel  currentSampleCriteriaChannel == criteriaChannel criteriaChannel->->DBValuesDBValues[[lastPosChecked lastPosChecked %%  
criteriaChannelcriteriaChannel->->DBBufSizeDBBufSize]];;
                floatfloat nextSampleCriteriaChannel  nextSampleCriteriaChannel == criteriaChannel criteriaChannel->->DBValuesDBValues[[((lastPosChecked lastPosChecked ++  11))  %%  
criteriaChannelcriteriaChannel->->DBBufSizeDBBufSize]];;

                // check if the two samples from Criteria channel are on different sides of Latch criteria// check if the two samples from Criteria channel are on different sides of Latch criteria
        bool crossedRisingEdgeCriteria         bool crossedRisingEdgeCriteria == currentSampleCriteriaChannel  currentSampleCriteriaChannel <=<= criteriaLimit  criteriaLimit &&&&  
nextSampleCriteriaChannel nextSampleCriteriaChannel >=>= criteriaLimit criteriaLimit;;
        bool crossedFallingEdgeCriteria         bool crossedFallingEdgeCriteria == currentSampleCriteriaChannel  currentSampleCriteriaChannel >=>= criteriaLimit  criteriaLimit &&&&  
nextSampleCriteriaChannel nextSampleCriteriaChannel <=<= criteriaLimit criteriaLimit;;

                // if user set the type of edge to rising edge and the Criteria channel crossed it// if user set the type of edge to rising edge and the Criteria channel crossed it
                // or user set the type of edge to falling edge and the Criteria channel crossed it// or user set the type of edge to falling edge and the Criteria channel crossed it
                ifif  ((((crossedFallingEdgeCriteria crossedFallingEdgeCriteria &&&& edgeType  edgeType ==== FallingEdge FallingEdge))  ||||  ((crossedRisingEdgeCriteria crossedRisingEdgeCriteria &&&&  
edgeType edgeType ==== RisingEdge RisingEdge))))
                {{
                        // add the value of the next sample from Input channel to the Latched channel// add the value of the next sample from Input channel to the Latched channel
                        floatfloat value  value == inputChannel inputChannel->->DBValuesDBValues[[((lastPosChecked lastPosChecked ++  11))  %% inputChannel inputChannel->->DBBufSizeDBBufSize]];;
            outputChannel            outputChannel->->AddAsyncSingleSampleAddAsyncSingleSample((valuevalue,,  ((lastPosChecked lastPosChecked ++  11))  // app app->->DataData--
>>SampleRateExSampleRateEx));;
                }}
        lastPosChecked        lastPosChecked++++;;
        }}
        returnreturn S_OK S_OK;;
}}

Writing to output channels and reading from input channels is only valid inside ::onGetData() procedure! Attempting to do
so from any other function might result in your plugin crashing! 
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Example I: Output result
We are now ready to test our plugin. We can do this by running your plugin by pressing F5 on your keyboard and going to
Ch. setup tab, then click the Latch math - Scalar button in the main toolbar in Dewesoft. A window like this should appear. 

Remember the setup we created and saved in Dewesoft before? We are going to use it here. We go to the Setup files tab
and double-click on the setup we want to load. The setup we loaded should include the two signals we created earlier and a
blank setup Latch Math - Scalar setup window.

We assign the signals to the Input and Criteria channel, set the Criteria limit and decide whether we are looking for a latch
conditions at rising or falling edge. Our setup should now look like this:

Now we can go to the Measure tab, where we can see a visual representation of the Latch.

Note that to get the exact picture below we turned off the Interpolate asynchronous channels option in the Drawing option of
the recorder setup, to better demonstrate that our values are "latched".
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In the picture above we can see that every time the sine signal passes 0 at the rising edge threshold, the output channel
outputs the current value of the time signal. The outputted value represents the time at which the sine signal passed 0.

Now change the edge type to falling edge and the criteria limit to 0,5. The results will now look like this:
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Example II: Vector latch math explanation
Our Latch math example can only output scalar sample values. But what if we wanted to latch a vector channel at some
condition? We can not just assign this channel as our input because our plugin does not know how to behave in the case of
a vector input. This problem can also be solved using C++ Plugin and we will do this by making some changes to our
current plugin. 

To understand which changes we need, let's first make a slight detour and explain the different types of channels in
Dewesoft.

Channel types
We can think of a channel in Dewesoft as a structure holding our signals. Channels can be split in two ways: the first split
is based on the value type of the channel, and the second one on its time base.

Based on their value type, channels can be split into:

scalar, vector, and matrix channels; where each of these could be
real, or complex channels.

This means that if you have e.g. a real vector channel all the samples in the channel are vectors (of same dimensions) with
real values. 

Based on their time base, channels can be split into:

synchronous;
asynchronous; and
single value.

Synchronous channels have equidistant time between consecutive samples. The time difference is defined by the
acquisition sample rate and channel's sample rate divider. Asynchronous channels, on the other hand, don't have this
restriction: the time between two consecutive samples can be arbitrary. Finally, single value channels don't care about time
at all, they only contain one single sample per entire measurement with no timestamp - meaning each new sample in the
single value channel simply overwrites the current value.

In Dewesoft only scalar channels can have a synchronous time base.

For a more visual example, the following image shows a sine curve in channels with different time bases.
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Synchronous and asynchronous channels use a circular buffer. This means that when the direct buffer is full, the newest
samples will override the oldest. Asynchronous channels also have an additional circular buffer used for storing
timestamps.

Signals for testing our module
With these terms explained, let's go back to our problem. Like we created scalar channels at the very start of the training,
let's now create some dummy vector channel for testing our modified module. One math module in Dewesoft that has
vectors as output is Fourier transform, so let's use that. We add a new Fourier transform setup from the Add math drop-
down list. We change the Resolution in Calculation parameters section to 256 lines (meaning the output vectors will have
256 elements) and click Ok.
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From Example I to Example II
Now that we have created a working plugin, we are ready to move to more complex concepts. We will use the project, which
was created in Example I and modify it to support vector channel. Example II will be more complex, so we will have to
modify things, which were simplified in Example I. We have already mentioned that all plugin logic, which does not need
Dewesoft internals, should be defined inside the proTutorial_LatchMath_vectorPluginLib project, although we did not take
that into account in Example I. So moving non-Dewesoft logic from the DewesoftBridge to the
proTutorial_LatchMath_vectorPluginLib will be the first thing we will do.

DewesoftBridge is used for communicating with Dewesoft internals, that is why it should only contain functions which are
meant to do that. This is why we will create a function for checking if we crossed the Criteria limit in the
proTutorial_LatchMath_vectorPluginLib. In the protutorial_latchmath_vector.h file we declare the method:

class proTutorial_LatchMath_vectorclass proTutorial_LatchMath_vector
{{
publicpublic
    bool     bool checkCrossedEdgeCriteriacheckCrossedEdgeCriteria((floatfloat currentSampleCriteriaChannel currentSampleCriteriaChannel,,  floatfloat nextSampleCriteriaChannel nextSampleCriteriaChannel,,  
floatfloat criteriaLimit criteriaLimit,,  intint edgeType edgeType));;
}};;

And in the protutorial_latchmath_vector.cpp file we define it.

bool proTutorial_LatchMath_vectorbool proTutorial_LatchMath_vector::::checkCrossedEdgeCriteriacheckCrossedEdgeCriteria((floatfloat currentSampleCriteriaChannel currentSampleCriteriaChannel,,
                                                                                                                        floatfloat nextSampleCriteriaChannel nextSampleCriteriaChannel,,
                                                                                                                        floatfloat criteriaLimit criteriaLimit,,
                                                                                                                        intint edgeType edgeType))
{{
    bool crossedRisingEdgeCriteria     bool crossedRisingEdgeCriteria == currentSampleCriteriaChannel  currentSampleCriteriaChannel <=<= criteriaLimit  criteriaLimit &&&&  
nextSampleCriteriaChannel nextSampleCriteriaChannel >=>= criteriaLimit criteriaLimit;;
    bool crossedFallingEdgeCriteria     bool crossedFallingEdgeCriteria == currentSampleCriteriaChannel  currentSampleCriteriaChannel >=>= criteriaLimit  criteriaLimit &&&&  
nextSampleCriteriaChannel nextSampleCriteriaChannel <=<= criteriaLimit criteriaLimit;;

        ifif  ((((crossedFallingEdgeCriteria crossedFallingEdgeCriteria &&&& edgeType  edgeType ====  11))  ||||  ((crossedRisingEdgeCriteria crossedRisingEdgeCriteria &&&& edgeType  edgeType ====  00))))
                returnreturn true true;;
        elseelse
                returnreturn false false;;
}}

Now, we have to change the method DewesoftBridgeDewesoftBridge::::onGetDataonGetData(()) in dewesoft_bridge.cpp file so it will use this new
method.

37



STDMETHODIMP DewesoftBridgeSTDMETHODIMP DewesoftBridge::::onGetDataonGetData(())
{{
        ifif  ((!!inputChannel inputChannel ||||  !!criteriaChannelcriteriaChannel))
                returnreturn S_OK S_OK;;

        intint blockSizeCriteriaChannel  blockSizeCriteriaChannel ==
                ((criteriaChannelcriteriaChannel->->DBPos DBPos --  ((lastPosChecked lastPosChecked %% criteriaChannel criteriaChannel->->DBBufSizeDBBufSize))  ++ criteriaChannel criteriaChannel--
>>DBBufSizeDBBufSize))  %% criteriaChannel criteriaChannel->->DBBufSizeDBBufSize;;
        intint blockSizeInputChannel  blockSizeInputChannel ==
                ((inputChannelinputChannel->->DBPos DBPos --  ((lastPosChecked lastPosChecked %% inputChannel inputChannel->->DBBufSizeDBBufSize))  ++ inputChannel inputChannel--
>>DBBufSizeDBBufSize))  %% inputChannel inputChannel->->DBBufSizeDBBufSize;;

        intint minBlockSize  minBlockSize ==  minmin((blockSizeCriteriaChannelblockSizeCriteriaChannel,, blockSizeInputChannel blockSizeInputChannel));;

        forfor  ((intint i  i ==  00;; i  i << minBlockSize  minBlockSize --  11;; i i++++))
        {{
                floatfloat currentSampleCriteriaChannel  currentSampleCriteriaChannel == criteriaChannel criteriaChannel->->DBValuesDBValues[[lastPosChecked lastPosChecked %%  
criteriaChannelcriteriaChannel->->DBBufSizeDBBufSize]];;
                floatfloat nextSampleCriteriaChannel  nextSampleCriteriaChannel == criteriaChannel criteriaChannel->->DBValuesDBValues[[((lastPosChecked lastPosChecked ++  11))  %%  
criteriaChannelcriteriaChannel->->DBBufSizeDBBufSize]];;
                
        bool crossedEdgeCriteria         bool crossedEdgeCriteria ==  
protutorial_latchmath_vectorprotutorial_latchmath_vector..checkCrossedEdgeCriteriacheckCrossedEdgeCriteria((currentSampleCriteriaChannelcurrentSampleCriteriaChannel,,
                                                                                         nextSampleCriteriaChannel                                                                                         nextSampleCriteriaChannel,,
                                                                                         criteriaLimit                                                                                         criteriaLimit,,
                                                                                         edgeType                                                                                         edgeType));;
                ifif  ((crossedEdgeCriteriacrossedEdgeCriteria))
                {{
                        floatfloat value  value == inputChannel inputChannel->->DBValuesDBValues[[((lastPosChecked lastPosChecked ++  11))  %% inputChannel inputChannel->->DBBufSizeDBBufSize]];;
            outputChannel            outputChannel->->AddAsyncSingleSampleAddAsyncSingleSample((valuevalue,,  ((lastPosChecked lastPosChecked ++  11))  // app app->->DataData--
>>SampleRateExSampleRateEx));;
                }}
        lastPosChecked        lastPosChecked++++;;
        }}
        returnreturn S_OK S_OK;;
}}

Because vector channels are always of asynchronous type, we also have to change the getSyncChannels() method to
getAsyncChannels() which will return all asynchronous channels. Do not forget to change the name of the method in
dewesoft_bridge.h file and in setup_window.cpp where we call this method.
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stdstd::::vectorvector<<IChannelPtrIChannelPtr>> DewesoftBridge DewesoftBridge::::getAsyncChannelsgetAsyncChannels(())
{{
    std    std::::vectorvector<<IChannelPtrIChannelPtr>> allChannels allChannels;;

    app    app->->DataData->->BuildChannelListBuildChannelList(());;
    IChannelListPtr channels     IChannelListPtr channels == app app->->DataData->->UsedChannelsUsedChannels;;

        forfor  ((intint i  i ==  00;; i  i << channels channels->->CountCount;; i i++++))
                ifif  ((channelschannels->->GetItemGetItem((ii))  !=!= outputChannel  outputChannel &&&& channels channels->->GetItemGetItem((ii))->->AsyncAsync))
            allChannels            allChannels..push_backpush_back((channelschannels->->GetItemGetItem((ii))));;

        returnreturn allChannels allChannels;;
}}

Since our Input channel will now be a vector channel, we also have to make changes to addChannelsToCBoxaddChannelsToCBox(()) method.
We will change this method so the inputChannelCBoxinputChannelCBox will only accept vector inputs and the criteriaChannelCBoxcriteriaChannelCBox  will
only accept scalar inputs.

voidvoid SetupWindow SetupWindow::::addChannelsToCBoxaddChannelsToCBox(())
{{
    criteriaChannelCBox    criteriaChannelCBox..clearclear(());;
    inputChannelCBox    inputChannelCBox..clearclear(());;

    std    std::::vectorvector<<IChannelPtrIChannelPtr>> allChannels  allChannels == bridge bridge..getAsyncChannelsgetAsyncChannels(());;
        forfor  ((intint i  i ==  00;; i  i << allChannels allChannels..sizesize(());; i i++++))
        {{
        std        std::::string channelName string channelName == allChannels allChannels[[ii]]->->NameName;;
                ifif  ((allChannelsallChannels[[ii]]->->ArrayChannelArrayChannel))
            inputChannelCBox            inputChannelCBox..addItemaddItem((channelNamechannelName));;                        
                elseelse
            criteriaChannelCBox            criteriaChannelCBox..addItemaddItem((channelNamechannelName));;
        }}
}}
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Example II: Saving and loading settings
Let's now start modifying our project. The reason for removing the non-Dewesoft logic from dewesoft_bridge.cpp file will be
seen soon, but not just yet.

It may be annoying for you to select channels, enter criteria limit and determine rising or falling edge every time you start
your plugin in Dewesoft. There is no need to do that anymore because C++ Plugin allows you to store and save your plugin
settings in an XML file. In our case, we should save information about Criteria limit, Input channel name and Criteria
channel name. To save enum settings we will change it to an integer and save it using WriteIntegerWriteInteger function.

Storing is done with methods that contain Write prefix (e.g. WriteInteger) and reading is done with methods that
contain Read prefix (e.g. ReadInteger). We will use class member doc which is automatically set. Parameters for Write and
Read methods depend on data type which should be saved, but we can generalize it for every data type. 

The first parameter is the pointer to the node which Dewesoft uses. This parameter is the same for every type.
The second parameter is the name of XML element under which your setting is saved. This parameter should be
unique for every setting.
The third parameter is the actual value to be stored.
The fourth parameter is the default value to be stored if the actual value is not yet initialized.

We will save plugin settings when setup is saved and load them when a new setup is loaded.

Storing our settings inside dewesoft_bridge.cpp file is done in onSaveSetup as seen in the code below.

voidvoid DewesoftBridge DewesoftBridge::::onSaveSetuponSaveSetup((constconst Setup Setup&& setup setup))
{{
        autoauto node  node == setup setup..getNodegetNode(());;
    node    node->->writewrite(("criteriaLimit_vector""criteriaLimit_vector",,  getCriteriaLimitgetCriteriaLimit(()),,  00));;
    node    node->->writewrite(("inputChannelName_vector""inputChannelName_vector",,  getInputChannelNamegetInputChannelName(())..c_strc_str(()),,  """"));;
    node    node->->writewrite(("criteriaChannelName_vector""criteriaChannelName_vector",,  getCriteriaChannelNamegetCriteriaChannelName(())..c_strc_str(()),,  """"));;
    node    node->->writewrite(("edgeType_vector""edgeType_vector",,  getEdgeTypegetEdgeType(()),,  00));;Â  Â Â Â  Â Â 
}}

Loading our settings inside dewesoft_bridge.cpp file is done as seen in the code below. We need to set the default values in
Read methods because onLoadSetup method is also called when a new plugin is created and XML elements (in
node variable) do not even exist yet. They are first added when the plugin is saved. Therefore names for our Input and
Criteria channel will be "" until the user chooses a channel name in ComboBox.
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voidvoid DewesoftBridge DewesoftBridge::::onLoadSetuponLoadSetup((constconst Setup Setup&& setup setup))
{{
        constconst  autoauto node  node == setup setup..getNodegetNode(());;
        
        floatfloat criteriaValue  criteriaValue ==  00;;
    node    node->->readread(("criteriaLimit_vector""criteriaLimit_vector",, criteriaValue criteriaValue,,  00));;
        setCriteriaLimitsetCriteriaLimit((criteriaValuecriteriaValue));;

    node    node->->readread(("inputChannelName_vector""inputChannelName_vector",, inputChannelName inputChannelName,,  """"));;
    node    node->->readread(("criteriaChannelName_vector""criteriaChannelName_vector",, criteriaChannelName criteriaChannelName,,  """"));;
        
        longlong edgeTypeVectorIndex edgeTypeVectorIndex;;
    node    node->->readread(("edgeType_vector""edgeType_vector",, edgeTypeVectorIndex edgeTypeVectorIndex,,  00));;
    edgeType     edgeType == edgeTypeVectorIndex  edgeTypeVectorIndex ====  00  ?? RisingEdge  RisingEdge :: FallingEdge FallingEdge;;
        
        mountChannelsmountChannels(());;
}}

We will also create a public method which will be used to fill input fields in SetupWindow class.

//setup_window.h//setup_window.h
voidvoid  setSavedValuessetSavedValues(());;

// setup_window.cpp// setup_window.cpp

voidvoid SetupWindow SetupWindow::::setSavedValuessetSavedValues(())
{{
    inputChannelCBox    inputChannelCBox..setSelectedIndexsetSelectedIndex((inputChannelCBoxinputChannelCBox..getIndexOfgetIndexOf((bridgebridge..getInputChannelNamegetInputChannelName(())))));;
        
criteriaChannelCBoxcriteriaChannelCBox..setSelectedIndexsetSelectedIndex((criteriaChannelCBoxcriteriaChannelCBox..getIndexOfgetIndexOf((bridgebridge..getCriteriaChannelNamegetCriteriaChannelName(())))));;

    latchCriteriaTBox    latchCriteriaTBox..setTextsetText((stdstd::::to_stringto_string((bridgebridge..getCriteriaLimitgetCriteriaLimit(())))));;

    edgeTypes savedEdgeType     edgeTypes savedEdgeType == bridge bridge..getEdgeTypegetEdgeType(());;
        ifif  ((savedEdgeType savedEdgeType ==== RisingEdge RisingEdge))
        risingEdgeRButton        risingEdgeRButton->->setIsCheckedsetIsChecked((risingEdgeRButtonrisingEdgeRButton..getIsEnabledgetIsEnabled(())));;
        elseelse
        fallingEdgeRButton        fallingEdgeRButton->->setIsCheckedsetIsChecked((fallingEdgeRButtonfallingEdgeRButton..getIsEnabledgetIsEnabled(())));;
}}

Input fields should also be filled every time when the plugin user interface is entered so the user will not have to set
channel names and Criteria limit again.
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voidvoid DewesoftBridge DewesoftBridge::::onSetupEnteronSetupEnter(())
{{
    setupWindow    setupWindow->->addChannelsToCBoxaddChannelsToCBox(());;
    setupWindow    setupWindow->->setSavedValuessetSavedValues(());;
}}

When Dewesoft is now opened and saved setup is loaded, saved values will load automatically.
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Example II: Vector latch math
Now that we know what Example II is about, we are ready to start with the main code: the code for handling vector channels.

In order to create our Output channel to support vectors, we will have to modify its mounting inside Dewesoft. It will accept
an array containing values of the type Single. That is why we have to set the channel's dimension (property DimCountDimCount) to
1. If we would need our Output channel to support matrix samples, we would have set DimCountDimCount  property to 2. We also set
the size of the vector we want to output. In this method, we will set it to 1 and we will change this property later to fit the
size of the input vectors.

voidvoid DewesoftBridge DewesoftBridge::::mountChannelsmountChannels(())
{{
        constconst std std::::vectorvector<<intint>> chIndexVector  chIndexVector ==  {{11}};;
    outputChannel     outputChannel == pluginGroup pluginGroup->->MountChannelExMountChannelEx((pluginGuidpluginGuid,,  longlong((chIndexVectorchIndexVector..sizesize(()))),,  
fromStdVecfromStdVec((chIndexVectorchIndexVector))));;

    outputChannel    outputChannel->->SetDataTypeSetDataType((longlong((ChannelDataTypeChannelDataType::::SingleSingle))));;
    outputChannel    outputChannel->->Name Name ==  "Latch""Latch";;
    outputChannel    outputChannel->->Unit_ Unit_ ==  """";;
    outputChannel    outputChannel->->SetAsyncSetAsync((truetrue));;
    outputChannel    outputChannel->->ExpectedAsyncRate ExpectedAsyncRate ==  55;;
    outputChannel    outputChannel->->Used Used == true true;;
    outputChannel    outputChannel->->ArrayChannel ArrayChannel == true true;;

    outputChannel    outputChannel->->ArrayInfoArrayInfo->->DimCount DimCount ==  11;;
    outputChannel    outputChannel->->ArrayInfoArrayInfo->->DimSizesDimSizes[[00]]  ==  11;;
    outputChannel    outputChannel->->ArrayInfoArrayInfo->->InitInit(());;
}}

Every time we make changes to the dimension of the array channel by setting the DimCount or DimSizes properties, we
need to call the Init() method.

There is one thing we need to keep an eye on: ExpectedAsyncRateExpectedAsyncRate property of our output channel. This warrants a slight
detour:

Expected async rate per second
If our module contains asynchronous output channels, we have to set their expected rate per second. You can think of this
as "approximately how many samples will I be adding to this channel per second". We can change the value of this setting
in DewesoftBridgeDewesoftBridge::::mountChannelsmountChannels(()) by modifying the channel's ExpectedAsyncRateExpectedAsyncRate. This setting is required
because we need to help Dewesoft figure out much memory it needs to reserve for our channel. While we can calculate this
value in any way we want, it can be useful if we know the rate of our output channel is somehow going to be connected to
the rate of some other input channel, in which case we can simply set the outputChanneloutputChannel->->ExpectedAsyncRateExpectedAsyncRate to
inputChannelinputChannel->->ExpectedAsyncRateExpectedAsyncRate.

We can set ExpectedAsyncRateExpectedAsyncRate to a completely arbitrary value, but if the ExpectedAsyncRateExpectedAsyncRate is set too high Dewesoft
will reserve too much memory and if it is set too low we might lose some important data. We don't need to set
ExpectedAsyncRateExpectedAsyncRate to the exact value, but we need to specify it to within an order of magnitude.
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Note that since our output channel is now a vector channel, Dewesoft will be reserving ArrayInfoArrayInfo->->ArraySizeArraySize times as
much memory as it would if the channel were a simple scalar channel; so we have to be extra careful to not put in a number
that is too high.
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Method DewesoftBridgeDewesoftBridge::::onEstablishConnectionsonEstablishConnections(()) is called when the acquisition is started (this occurs when ch.
setup is entered). In this method, we will retrieve the Input and Criteria channels by their names. If names are not yet set
(this will happen every time when no channel had been set in ComboBoxes containing channel names), we do not set any
channels. 

STDMETHODIMP DewesoftBridgeSTDMETHODIMP DewesoftBridge::::onEstablishConnectionsonEstablishConnections(())
{{
        setInputChannelsetInputChannel((inputChannelNameinputChannelName..c_strc_str(())));;
        setCriteriaChannelsetCriteriaChannel((criteriaChannelNamecriteriaChannelName..c_strc_str(())));;

        returnreturn S_OK S_OK;;
}}

As mentioned before, we still need to set the size of the vectors we want to output. This needs to be done before Dewesoft
reserves space to run our plugin, so we have to add an event that gets triggered before this happens. This event is called
evPreInitiateevPreInitiate and we need to add it to plugin_impl.cpp file, where we also define the method that gets triggered when this
event happens. The method needs to be declared in the plugin_impl.h file.

// plugin_impl.h// plugin_impl.h
//IPlugin4//IPlugin4
STDMETHODIMP STDMETHODIMP eventBeforeReserveMemoryeventBeforeReserveMemory(());;

// plugin_impl.cpp// plugin_impl.cpp
STDMETHODIMP PluginSTDMETHODIMP Plugin::::raw_OnEventraw_OnEvent((enumenum EventIDs eventID EventIDs eventID,, VARIANT inParam VARIANT inParam,, VARIANT VARIANT** outParam outParam))
{{
        // ...// ...
        switchswitch  ((eventIDeventID))
        {{
                // ...// ...
                casecase evPreInitiate evPreInitiate::
            returnValue             returnValue ==  eventBeforeReserveMemoryeventBeforeReserveMemory(());;
                        breakbreak;;
                // ...// ...
        returnreturn returnValue returnValue;;
}}

STDMETHODIMP PluginSTDMETHODIMP Plugin::::eventBeforeReserveMemoryeventBeforeReserveMemory(())
{{
        returnreturn bridge bridge..onBeforeReserveMemoryonBeforeReserveMemory(());;
}}

As we see in the code above the method that gets triggered when evPreInitiate happens triggers a method defined in
DewesoftBridge. We will add the declaration and definition of this method to the bridge.
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// dewesoft_bridge.h// dewesoft_bridge.h
STDMETHODIMP STDMETHODIMP onBeforeReserveMemoryonBeforeReserveMemory(());;

// dewesoft_bridge.cpp// dewesoft_bridge.cpp
STDMETHODIMP DewesoftBridgeSTDMETHODIMP DewesoftBridge::::onBeforeReserveMemoryonBeforeReserveMemory(())
{{
        ifif  ((!!inputChannelinputChannel))
                returnreturn S_OK S_OK;;

    outputChannel    outputChannel->->ArrayInfoArrayInfo->->DimCount DimCount ==  11;;
    outputChannel    outputChannel->->ArrayInfoArrayInfo->->DimSizesDimSizes[[00]]  == inputChannel inputChannel->->ArraySizeArraySize;;
    outputChannel    outputChannel->->ArrayInfoArrayInfo->->InitInit(());;
    outputChannel    outputChannel->->ArrayInfoArrayInfo->->AxisDefAxisDef[[00]]->->Name Name == inputChannel inputChannel->->ArrayInfoArrayInfo->->AxisDefAxisDef[[00]]->->NameName;;
    outputChannel    outputChannel->->ArrayInfoArrayInfo->->AxisDefAxisDef[[00]]->->_Unit _Unit == inputChannel inputChannel->->ArrayInfoArrayInfo->->AxisDefAxisDef[[00]]->->_Unit_Unit;;

    outputChannel    outputChannel->->ArrayInfoArrayInfo->->AxisDefAxisDef[[00]]->->AxisType AxisType == atFloatLinearFunc atFloatLinearFunc;;
    outputChannel    outputChannel->->ArrayInfoArrayInfo->->AxisDefAxisDef[[00]]->->StartValue StartValue == inputChannel inputChannel->->ArrayInfoArrayInfo->->AxisDefAxisDef[[00]]--
>>StartValueStartValue;;
    outputChannel    outputChannel->->ArrayInfoArrayInfo->->AxisDefAxisDef[[00]]->->StepValue StepValue == inputChannel inputChannel->->ArrayInfoArrayInfo->->AxisDefAxisDef[[00]]--
>>StepValueStepValue;;

        returnreturn S_OK S_OK;;
}}

We have now successfully mounted an output channel to Dewesoft, set its axis values, and updated the Output channel to
support outputting vector values from the Input channel. All there is left to do is to actually output vector values
to the Output channel. 

This will be done inside onGetDataonGetData(()) method. For precautionary reasons, we also check if the Input channel or Criteria
Channel is nullptr, otherwise, the Input channel could be uninitialized when new setup was created. To insert data to the
Output channel we will use the method AddAsyncDataAddAsyncData((......)) which allows insertion of a vector to the Output channel.
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STDMETHODIMP DewesoftBridgeSTDMETHODIMP DewesoftBridge::::onGetDataonGetData(())
{{
        ifif  ((!!inputChannel inputChannel ||||  !!criteriaChannelcriteriaChannel))
                returnreturn S_OK S_OK;;

        ifif  ((inputChannelinputChannel->->DBDataSize DBDataSize ====  00  |||| criteriaChannel criteriaChannel->->DBDataSize DBDataSize ====  00))
                returnreturn S_OK S_OK;;

        intint blockSizeCriteriaChannel  blockSizeCriteriaChannel ==
                ((criteriaChannelcriteriaChannel->->DBPos DBPos --  ((lastPosChecked lastPosChecked %% criteriaChannel criteriaChannel->->DBBufSizeDBBufSize))  ++ criteriaChannel criteriaChannel--
>>DBBufSizeDBBufSize))  %% criteriaChannel criteriaChannel->->DBBufSizeDBBufSize;;

        forfor  ((intint i  i ==  00;; i  i << blockSizeCriteriaChannel  blockSizeCriteriaChannel --  11;; i i++++))
        {{
                floatfloat currentSampleCriteriaChannel  currentSampleCriteriaChannel == criteriaChannel criteriaChannel->->DBValuesDBValues[[lastPosChecked lastPosChecked %%  
criteriaChannelcriteriaChannel->->DBBufSizeDBBufSize]];;
                floatfloat nextSampleCriteriaChannel  nextSampleCriteriaChannel == criteriaChannel criteriaChannel->->DBValuesDBValues[[((lastPosChecked lastPosChecked ++  11))  %%  
criteriaChannelcriteriaChannel->->DBBufSizeDBBufSize]];;

        bool crossedEdgeCriteria         bool crossedEdgeCriteria ==  
protutorial_latchmath_vectorprotutorial_latchmath_vector..checkCrossedEdgeCriteriacheckCrossedEdgeCriteria((currentSampleCriteriaChannelcurrentSampleCriteriaChannel,,
                                                                                         nextSampleCriteriaChannel                                                                                         nextSampleCriteriaChannel,,
                                                                                         criteriaLimit                                                                                         criteriaLimit,,
                                                                                         edgeType                                                                                         edgeType));;
                ifif  ((crossedEdgeCriteriacrossedEdgeCriteria))
                {{
                        doubledouble time  time == criteriaChannel criteriaChannel->->DBTimeStampDBTimeStamp[[((lastPosChecked lastPosChecked ++  11))  %% criteriaChannel criteriaChannel->->DBBufSizeDBBufSize]];;

                        intint posInputChannel  posInputChannel ==  ((inputChannelinputChannel->->DBPos DBPos --  11));;

                        // reading vector from channel// reading vector from channel
            std            std::::vectorvector<<floatfloat>> results results;;
                        forfor  ((intint j  j ==  00;; j  j << outputChannel outputChannel->->ArraySizeArraySize;; j j++++))
                        {{
                                floatfloat value  value == inputChannel inputChannel->->DBValuesDBValues[[posInputChannel posInputChannel ** inputChannel inputChannel->->ArraySize ArraySize ++ j j]];;
                results                results..push_backpush_back((valuevalue));;
                        }}

                        ifif  ((outputChanneloutputChannel))
                outputChannel                outputChannel->->AddAsyncDataAddAsyncData((fromStdVecfromStdVec((resultsresults)),, time time));;
                }}
        lastPosChecked        lastPosChecked++++;;
        }}
        returnreturn S_OK S_OK;;
}}
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Example II: Debugger
Because C++ Plugin uses Visual Studio IDE, it supports really efficient debugging. It helps you find semantic errors, see
variable values in real-time, set breakpoints, add watches on variables to see values changing, and much more. 

If we now run our plugin by pressing the F5 on the keyboard, load the setup we created for testing the plugin and assign the
channels as seen in image 29.

Then enter the Measure mode in Dewesoft we quickly get an error message.

We can see that the error is thrown in the OnGetDataOnGetData(()) method. We will now set a breakpoint inside of this method, start
our plugin with F5 keystroke again and go to Measure tab. When the program execution reaches our breakpoint we will be
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able to look at every line of code to find out, which one is causing our plugin to crash. To move to the next line use the F10
keystroke (this will step over function calls).

We will try to find the error using Visual Studio Debugger. 

After some iterations, we can see that posInputChannelposInputChannel has a value of -1 when the last position of the Input channel is 0.
This happens because the data in channels is stored in circular buffers and when we try to access the channel values using
the inputChannelinputChannel->->DBValuesDBValues[[......]] we get an error.
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Debugging will not always be that easy. In this case, Call stack (the window in the bottom-right corner) is something to keep
an eye on. It will show you how methods were called and allow you to step up the stack by clicking the call stack line to see
the actual call.

Now we know what is the source of the problem, so we are able to fix it. We change the posInputChannels to first check if
the position of the last value received in the Input channels is 0, and if it is, the value we want to output is not -1 but it is the
last element of the buffer.

intint posInputChannel  posInputChannel == inputChannel inputChannel->->DBPos DBPos !=!=  00  ?? inputChannel inputChannel->->DBPos DBPos --  11  :: inputChannel inputChannel->->DBBufSizeDBBufSize  
--  11;;
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Example II: Unit testing
One of the important stages of plugin development is testing. Luckily, C++ Plugin allows you to run automated unit tests,
which will shorten your testing time. Unit testing is a software testing method that tests your plugin by running predefined
test cases and checking if the result is correct. 

Unit testing is one of the main reasons for separating the Dewesoft logic (defined inside DewesoftBridge) and non-
Dewesoft logic (defined inside proTutorial_LatchMath_vectorPluginLib). 

We can now test each segment without having to start Dewesoft. In order to perform unit tests, you have to set
proTutorial_LatchMath_vectorPluginTest as your startUp project (right clicking it and clicking on set as startUp project). We
will get rid of sample code so we will only test functions which we need. Every test is written inside
protutorial_latchmath_vector_item_test.cpp file. 

We will create two simple unit tests, to test our method checkCrossedEdgeCriteriacheckCrossedEdgeCriteria((......)) . If the returned value is the same
as the one set, the unit test will output "PASSED".

Here you can see two examples of a unit test (both should successfully pass).

51



TEST_FTEST_F((proTutorial_LatchMath_vectorItemTestproTutorial_LatchMath_vectorItemTest,, CheckCriteriaLimitRisingEdge CheckCriteriaLimitRisingEdge))
{{
    proTutorial_LatchMath_vector protutorial_latchmath_vector    proTutorial_LatchMath_vector protutorial_latchmath_vector;;

        floatfloat currentSampleCriteriaChannel  currentSampleCriteriaChannel ==  0.490.49;;
        floatfloat nextSampleCriteriaChannel  nextSampleCriteriaChannel ==  0.510.51;;
        floatfloat criteriaLimit  criteriaLimit ==  0.50.5;;
        intint edgeType  edgeType ==  00;;  // RisingEdge// RisingEdge

    bool crossedEdgeCriteria     bool crossedEdgeCriteria ==  
protutorial_latchmath_vectorprotutorial_latchmath_vector..checkCrossedEdgeCriteriacheckCrossedEdgeCriteria((currentSampleCriteriaChannelcurrentSampleCriteriaChannel,,
                                                                                     nextSampleCriteriaChannel                                                                                     nextSampleCriteriaChannel,,
                                                                                     criteriaLimit                                                                                     criteriaLimit,,
                                                                                     edgeType                                                                                     edgeType));;
        ASSERT_TRUEASSERT_TRUE((crossedEdgeCriteriacrossedEdgeCriteria));;
}}

TEST_FTEST_F((proTutorial_LatchMath_vectorItemTestproTutorial_LatchMath_vectorItemTest,, CheckCriteriaLimitFallingEdge CheckCriteriaLimitFallingEdge))
{{
    proTutorial_LatchMath_vector protutorial_latchmath_vector    proTutorial_LatchMath_vector protutorial_latchmath_vector;;

        floatfloat currentSampleCriteriaChannel  currentSampleCriteriaChannel ==  --0.120.12;;
        floatfloat nextSampleCriteriaChannel  nextSampleCriteriaChannel ==  0.010.01;;
        floatfloat criteriaLimit  criteriaLimit ==  00;;
        intint edgeType  edgeType ==  11;;  // FallingEdge// FallingEdge

    bool crossedEdgeCriteria     bool crossedEdgeCriteria ==  
protutorial_latchmath_vectorprotutorial_latchmath_vector..checkCrossedEdgeCriteriacheckCrossedEdgeCriteria((currentSampleCriteriaChannelcurrentSampleCriteriaChannel,,
                                                                                     nextSampleCriteriaChannel                                                                                     nextSampleCriteriaChannel,,
                                                                                     criteriaLimit                                                                                     criteriaLimit,,
                                                                                     edgeType                                                                                     edgeType));;
        ASSERT_FALSEASSERT_FALSE((crossedEdgeCriteriacrossedEdgeCriteria));;
}}

To see the result of unit tests, we have to start your project. The result is outputted in the command prompt, which
terminates after the testing is completed. In order for the command prompt to stay visible, we should place a breakpoint
right before returnreturn res res;; line of code in main.cpp file. In the picture below you can see an example of setting a breakpoint.

The output in the command prompt should look like that.
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Example II: Output
If you now start your plugin and set your Input channel to AI 1/AmplFFT and Criteria channel to sine(1), as seen in the image
35.

You will be able to see the outputted vectors on a 3D graph. A new vector is outputted every time the sine(1) signal passes
the value 0.5 on the rising edge.
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As you can see, whenever sine(1) crosses the Criteria limit, we output the last vector sample from our input channel
AI1/AmplFFT to our Output channel.
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How to Import/Export the C++ plugin?
In this Pro Training, we have created a pretty useful plugin, which inserts samples into our  Output channel. We might want
to use it in other setups or on other computers. C++ Plugin packs your plugin into an external library, which can be inserted
into any Dewesoft around the world.

Your C++ Plugin is found inside a file with .dll extension (it contains instructions that Dewesoft can call upon to do certain
things, based on the purpose of your plugin). To export it, you need to locate the .dll file first. It can be found inside
DEWESoftX\DEWEsoft\Bin\Addons folder.

To import your plugin you have to copy and paste file with .dll extension into any Dewesoft that requires your plugin. You
need to paste it inside Addons folder so Dewesoft will be able to automatically recognize and load it.

Your C++ Plugin also creates a file with the .pdb extension, which contains instructions for your debugger. It is not
necessary to export it with your .dll file in order for your plugin to work, but in case the imported plugin will be debugged,
copying it together with a .dll file is a good idea.
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Comparison with the other ways of extending Dewesoft
At this point, you might have a pretty good grasp on how to use C++ Script. But C++ Script is just one of many ways of
extending Dewesoft to suit your needs, and it might be slightly confusing to try and figure out if it actually is the best
solution for your task. So in this section, we briefly compare different approaches and list a couple of pros and cons which
can hopefully help you pick the right tool.

Just a quick reminder: Dewesoft is a big software. It is always worth trying to figure out if Dewesoft can already do
whatever you need out of the box, because if it can, you will waste very little of your time, and will have full support from
Dewesoft team if anything doesn't work as expected.

Extention Description

Formula

If you want to manipulate channels in a simple way, the Formula module is usually the best one to
start experimenting with. Because of its ease of use, it can serve as a great starting point for quick
prototyping, and it is usually good enough for most typical problems (signal generation, simple
manipulation of data in channels, etc.).

C++ Script

During its development, we mainly envisioned C++ Script as a tool to create custom math modules
that you could export and use just like standard Dewesoft modules. C++ Script is probably a good
second step after your approach with Formula modules gets too complicated, too cluttered, or, in
the worst case, you cannot figure out how to solve the problem with them.

Plugins

If you want to develop anything other than math modules, or if you tried creating a module with C++
Script and it proved to not be fast or powerful enough, or if you want to create a completely custom
GUI for your module, Plugins are the right way to go. With Dewesoft Plugins you get access to entire
Dewesoft from your code, including direct access to buffers behind channels, making Plugins
incredibly fast compared to C++ Script.

Sequencer / DCOM

Sequencer and DCOM are slightly different than the other 3 approaches mentioned in this section.
Regardless, they serve a very useful purpose and deserve to be mentioned here: they are used to
automate a person clicking on different parts of the Dewesoft UI. The difference among them is that
with Sequencer you can create sequences by dragging and dropping graphical blocks (requiring
little to no experience with programming) while with DCOM you need to use a programming
language. Sequencer is easier to use, but you get much more control with DCOM.

Extention PROS CONS

Formula

- The most intuitive of all the approaches, very simple to
use.

- Integrated fully into Dewesoft meaning no set up
required to get running.

- Input channels are fixed in the formula,
making reusability a lot of work.

- While it supports combining arbitrarily
many input channels, it always produces
just one output channel.

- Poor support for non-scalar channels.

C++ script

- Dewesoft setups look much nicer as you (usually) only
need one C++ Script to solve a problem that would require
a bunch of Formula modules

- Reusability and generality of your module: you can hide
the code from the end-user and only expose the Published
setup tab.

- It can work with an arbitrary amount of input and output
channels.

- Requires familiarity with at least basics
of programming in C++.

- Difficult to test and debug.
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Plugins

- Much easier to write nice code with proper unit tests.

- Full control over the creation of GUI, access to Dewesoft
internals, and blazing fast.

- It can be used to create custom export formats, custom
visual controls, add support for additional acquisition
devices, ...

- Made to work with Visual Studio, giving you access to a
great debugger, code completion, and other static analysis
tools.

- Requires Visual Studio.

- Much harder to learn to use than C++
Script.

Sequencer / DCOM

- It can be used to create an automated sequence of
events in Dewesoft.

- Creator of the sequence can hide the details from the
end-user, exposing only a simple user interface to control
Dewesoft.

/
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